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Technology Licenses
The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer 
software,” as defined by Federal Acquisition 
Regulation (“FAR”) 2.101. Pursuant to FAR 
12.212 and 27.405-3 and Department of 
Defense FAR Supplement 

(“DFARS”) 227.7202, the U.S. government 
acquires commercial computer software 
under the same terms by which the soft-
ware is customarily provided to the public. 
Accordingly, Keysight provides the Soft-
ware to U.S. government customers under 
its standard commercial license, which is 
embodied in its End User License Agree-
ment (EULA), a copy of which can be found 
at http://www.keysight.com/find/sweula. 
The license set forth in the EULA represents 

the exclusive authority by which the U.S. 
government may use, modify, distribute, or 
disclose the Software. The EULA and the 
license set forth therein, does not require 
or permit, among other things, that Key-
sight: (1) Furnish technical information 
related to commercial computer software 
or commercial computer software docu-
mentation that is not customarily provided 
to the public; or (2) Relinquish to, or other-
wise provide, the government rights in 
excess of these rights customarily provided 
to the public to use, modify, reproduce, 
release, perform, display, or disclose com-
mercial computer software or commercial 
computer software documentation. No 
additional government requirements 
beyond those set forth in the EULA shall 
apply, except to the extent that those 
terms, rights, or licenses are explicitly 
required from all providers of commercial 
computer software pursuant to the FAR and 
the DFARS and are set forth specifically in 
writing elsewhere in the EULA. Keysight 
shall be under no obligation to update, 
revise or otherwise modify the Software. 
With respect to any technical data as 
defined by FAR 2.101, pursuant to FAR 
12.211 and 27.404.2 and DFARS 227.7102, 
the U.S. government acquires no greater 
than Limited Rights as defined in FAR 
27.401 or DFAR 227.7103-5 (c), as appli-
cable in any technical data. 

Warranty

THE MATERIAL CONTAINED IN THIS DOCU-
MENT IS PROVIDED "AS IS," AND IS SUB-
JECT TO BEING CHANGED, WITHOUT 
NOTICE, IN FUTURE EDITIONS. FURTHER, 
TO THE MAXIMUM EXTENT PERMITTED BY 
APPLICABLE LAW, KEYSIGHT DISCLAIMS 
ALL WARRANTIES, EITHER EXPRESS OR 
IMPLIED WITH REGARD TO THIS MANUAL 
AND ANY INFORMATION CONTAINED 
HEREIN, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MER-
CHANTABILITY AND FITNESS FOR A PAR-

TICULAR PURPOSE. KEYSIGHT SHALL NOT 
BE LIABLE FOR ERRORS OR FOR INCIDEN-
TAL OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH THE FURNISHING, 
USE, OR PERFORMANCE OF THIS DOCU-
MENT OR ANY INFORMATION CONTAINED 
HEREIN. SHOULD KEYSIGHT AND THE 
USER HAVE A SEPARATE WRITTEN AGREE-
MENT WITH WARRANTY TERMS COVER-
ING THE MATERIAL IN THIS DOCUMENT 
THAT CONFLICT WITH THESE TERMS, THE 
WARRANTY TERMS IN THE SEPARATE 
AGREEMENT WILL CONTROL.

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. 
It calls attention to an operating pro-
cedure, practice, or the like that, if 
not correctly performed or adhered 
to, could result in damage to the 
product or loss of important data. Do 
not proceed beyond a CAUTION 
notice until the indicated conditions 
are fully understood and met. 

WARNING
A WARNING notice denotes a hazard. 
It calls attention to an operating pro-
cedure, practice, or the like that, if 
not correctly performed or adhered 
to, could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Compliance and Environmental Information

Table 1  Compliance and Environmental Information

Safety Symbol Description

This product complies with WEEE Directive (2002/96/EC) marking requirements. 
The affixed label indicates that you must not discard this electrical/electronic 
product in domestic household waste.

Product Category: With reference to the equipment types in WEEE Directive Annex I, 
this product is classed as a “Monitoring and Control instrumentation” product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office, or see
http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more 
information.
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Extended Measurement Setup

The extended setup and trigger details are illustrated in the following 
figure:

The LS engine may be used with up to three tunable laser sources, 
covering multiple wavelength bands. If more than one TLS is used, an 
optical switch is required as well, such as the N7731A or the 81595B 
module in one of the mainframes. In addition to supporting multiple power 
meters and Source Measure Units, an optical return loss module 81610A 
or 81613A can be used.
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Measurement Setup for PMD Mode

The following figure shows the hardware setup required to perform the 
PMD measurements.

The N7788C Optical Component Analyzer combines polarization control 
functions and polarimetric measurement functions within a single 
instrument. Therefore, optical connections are reduced to a minimum. A 
tunable laser source (TLS) is connected to the input and the device under 
test (DUT) is connected to the corresponding optical ports.

Other than the N7786C, the N7788C comprises an internal optical switch. 
In addition to every reference and device measurement sweep, this switch 
is employed to run an internal reference sweep, which makes 
measurements more robust against environmental changes between the 
time of taking the reference and performing a measurement. Also, it 
improves the result when reference measurement has been obtained with 
different settings than those selected for the device measurement.

The engine also supports combining up to three lasers with an optical 
switch for PMD mode. However, a return loss module is not supported. 
Only single-port measurements can be performed, as the N7788C is the 
only data acquisition instrument capable of measuring the complete state 
of polarization. That is also the reason why neither power meters nor SMUs 
are supported in PMD mode.
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Trigger Connections

The following points must be kept in mind while configuring the triggering 
connections for setups with multiple instruments.

• The engine automatically configures all mainframes and laser 
instruments that are included in the current configuration, assuming 
they are daisy-chained as shown in the above illustration. If an 
instrument in the physical trigger path is not included in the current 
configuration, it will not be configured by the engine and thus, most 
likely, interrupt the daisy chain. 
When including a Lightwave Measurement System (LMS) mainframe in 
the configuration that does not contain any module used by the current 
configuration, it will be configured to pass through triggers from input 
to output.

• Any instrument or mainframe that is included in a configuration will be 
preset upon engine activation. In case of LMS modules, the hosting 
mainframe will be preset, which causes all modules to be preset as 
well. So, when including a mainframe solely to get the trigger path set 
to passthrough mode, be aware that the mainframe will be preset too.
However, there is one exception to this behavior. In case the only LMS 
module used from a mainframe is an optical switch, then the mainframe 
does not need to be added to the configuration automatically and will 
not be preset, in case it is not included explicitly.

• When other instruments not used by the software are connected to the 
trigger paths, care should be taken to avoid unexpected behavior.

• Standard RG-58 (50 ohm) BNC cables must be used.

• Use the N7786-61601 trigger cable to connect the N7786B expansion 
port to the first power/current meter instrument.

• Connect each trigger output of the TLS instruments to the trigger input 
of the next TLS and the last trigger output to the trigger input of the 
N7786B/C in case of setups for polarization-resolved measurements or 
to the power meter(s) and/or SMU(s) otherwise.

• If an 81610A or an 81613A return loss module is used in the setup, it 
must be placed in the last mainframe of the TLS/mainframe daisy 
chain, i.e., the one that is connected to the trigger input of the 
N7786B/C (in case of setups for polarization-resolved measurements or 
to the power meter(s) and/or SMU(s) otherwise) so that it can receive 
triggers from any of the TLS. (This is automatically fulfilled if only a 
single TLS is used in the setup). Alternatively, it can be placed in a 
separate mainframe with its input trigger port connected parallel to the 
power meters and SMUs (use BNC-Tee(s)).
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• If one or more power meters/optical head interface modules are used in 
a mainframe with one of the TLS, they must be placed in the first 
mainframe of the TLS/mainframe daisy chain (This is automatically 
fulfilled if only a single mainframe is used in the setup). The input 
trigger of this mainframe should be connected to the trigger output of 
the N7786B/C (in case of setups for polarization-resolved 
measurements or to the power meter(s) and/or SMU(s) otherwise). 
Alternatively, it can be placed in a separate mainframe with its input 
trigger port connected parallel to the power meters and SMUs (use 
BNC-Tee(s)).

• All data acquisition instruments should receive input triggers from the 
N7786B/C (in case of setups for polarization-resolved measurements). 
Power meter instruments that support this functionality (N7744A/C, 
N7745A/C, N7747A/C, N7748A/C, N7742C, N7743C, or N7749C) will 
be configured by the software to pass triggers from the input to the 
output, so they can be series-connected in a daisy chain, like the TLS 
instruments.

• If more than one power meter/SMU is used in the setup that is not an 
N7744A/C, N7745A/C, N7747A/C, N7748A/C, N7742C, N7743C, or 
N7749C use BNC Tee connectors to split the trigger signal accordingly.

• For measuring photocurrent with the supported B2900-series 
source/measure units, use the N1294A-031 trigger adapter to connect 
the trigger signal (i.e., the output of the BNC 50 ohms trigger cable or a 
respective tee connector) to the Digital I/O port of each SMU. (DIO9). 
There is currently no trigger passthrough configuration for 
B2900-series instruments.

Figure 1 N1294A-031 GPIO - BNC Trigger Adapter

• For the M9601A/M9614A/M9615A SMUs, the following accessories are 
recommended for triggering purposes:
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• One M9601-87002 Connector-terminal block 2.5 mm 6-terminal for 
each M9601A (comes with the M9601A instrument) 
Or 
One M9615-87001 Connector-terminal block 2.5 mm 5-terminal for 
each M9614A/M615A (comes with the M9614A/M9615A 
instrument)

• One PX0101A-001 or PX0101A-002 BNC-Ferrule Terminal Cable

One such set is required per SMU and the terminal block is plugged 
into the front panel of each SMU module. Connect the two wires of the 
ferrule cable to the top two slots of the terminal block, thus enabling 
EXT1 trigger, which is used by this software. The Configuration Wizard 
enables using EXT2 input as well, which uses different slots on the 
connector block (see SMU User’s Guide or front panel indications).

Using the above accessories, each SMU module is triggered directly, 
and completely independent of the PXIe chassis and whether an 
embedded controller PC is used or not.

In case there are multiple SMU modules to be used in a chassis, PXI 
backplane triggering can be used. Both PXI chassis and embedded 
controller PCs might offer trigger input ports (usually SMB connector 
type, so either PX0108A-001 or PX0108A-002 SMB to BNC adapter 
cables are recommended). Refer to PXIe chassis and embedded 
controller documentation for details on how to map the respective 
input triggers to the PXI backplane lines. Note that there might be 
limitations on which chassis slots the backplane lines can be routed 
from/to simultaneously.

The Configuration Wizard enables using any of the backplane trigger 
lines (PXI0-PXI7), in addition to the two module trigger inputs (EXT1 
and EXT2).
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Receiver Characterization using M9601A/M9614A/M9615A SMU instruments

Figure 3 M9601A SMU instrument

The following points should be kept in mind when performing receiver 
characterization using M9601A/M9614A/M9615A SMU instrument:

• This software does not support multi-chassis configurations.

• When selecting M9601A/M9614A/M9615A in the Configuration 
Wizard, ensure that the M9601A/M9614A/M9615A Soft Front Panel 
(SFP) is not running; otherwise, you won’t be able to connect to the 
module. Similarly, you will not be able to open the 
M9601A/M9614A/M9615A module's Soft Front Panel while an LS 
Engine configuration comprising that module is active.

• Since M9601A/M9614A/M9615A is a module in a PXIe chassis, there 
are only two ways to connect the PXIe mainframe (and, thus, 
M9601A/M9614A/M9615A module) to the Photonic Application 
Software software:

• Using an embedded controller PC module, such as the 
M9036A/37A, in the mainframe and run Photonic Application Suite 
and LS engine on that PC
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Receiver Characterization using N7745A instruments

A special customization of the N7745A, identified by option E02 replaces 4 
of the optical power meter ports with photocurrent input ports through 
triaxial front-panel connectors.

For connecting the DUT, insulated triax-to-coax adapters (1250-2650) are 
recommended. The (negative) bias voltage (-4 to 0V) will then be 
connected to the coax shielding. While the instrument is powered, the 
center contact will be at N7745A case ground potential.

N7745A instruments measure photocurrent in a single polarity only. The 
photodiode cathode must be connected to the triax/coax center contact. 
Only negative biasing is available.

A single N7745A port’s bias voltage source can be used for multiple 
measurement ports. This is required for DUTs with multiple photodiodes 
with common anodes.

N7745A does not have a controlled current limitation. However, there is an 
absolute limitation, since their bias voltage sources can only provide a 
maximum current of 20mA.

Care should be taken regarding induced distortions. Best results are 
achieved with shielded cables. Twisted wires and wires within a single flat 
ribbon cables usually work fine as well.
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Software User Interface

Figure 4 The Launch Pad gives you access to the installed components. Click on 
“Lambda Scan” to start the LS Engine

NOTE
The LS Engine consists of a Client Software which handles the graphical 
input/output and a Server Software which handles the communication 
with the hardware. For remote control or automation, the controlling 
program communicates directly with the Server Software. The server will 
be automatically started when you click on “Lambda Scan”. The presence 
of the server is indicated in the task bar:
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About this manual

This manual describes how to use the Photonic Application Suite Lambda 
Scan application for fast swept-wavelength measurements with a variety 
of hardware configurations for obtaining different results.

• Configurations using one to three tunable lasers and a number of 
optical power meter or SMU instruments, and an optional return loss 
module are enabled with the N7700102C FLS or N7700100C PLS 
license.

• For polarization-dependent loss measurements, the N7786B/C can be 
added to these configurations with the N7700100C PLS license.

• For polarization-dependent measurements including differential group 
delay (DGD) / polarization mode dispersion (PMD), the N7788C can be 
configured with one to three tunable lasers and the N7700103C PMD 
license. Please note that these configurations do not support Return 
Loss measurements.

You might also refer to the N7700 Keysight Photonic Application Suite 
User's Guide to get information on the core Photonic Application Suite 
functionality including the File Viewer, Plugins, and the general COM API. 
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System Requirements

• One to three Keysight continuous-sweep tunable laser source (N7776C, 
N7778C, 81960A, 81940A, 81980A or any TLS models for 8164B Slot 0, 
e.g., 81600B, 81602A, 81606A, 81607A, or 81608A.)

• One Optical Switch (81595B, N7731A (left switch only), or N7734A) in 
case more than one tunable laser source is used

• One N7786B/C Polarization Synthesizer (optional)

• One N7788C Optical Component Analyzer (optional)

• One or more power meter/SMU instruments: 

• N7742C

• N7743C

• N7744A /N7745A

• N7744C / N7745C

• N7745A-E01/-E02

• N7747A/N7748A

• N7747C/N7748C

• 8162xC (81623C, 81624C, 81626C, or 81628C) Optical power meter 
head connected to N7749C

• B2901A/B/BL, B2902A/B, B2910BL, B2911A/B, B2912A/B

• M9601A/M9614A/M9615A

• 81636B

• 8162xB Optical power meter head connected to 81619A, N7749C

• Up to one 81610A / 81613A return loss module

• One or more 8163B or 8164B mainframes (in case any Lightwave 
Measurement System modules are included in the configuration)

• The following patchcords are required:

• one patchcord per TLS (single-mode or polarization maintaining)

• one additional (single mode) patchcord in case of a multi-TLS setup

• one additional (single mode) patchcord in case a return loss module 
is included in the configuration

• one additional (single mode) patchcord in case an 
N7786B/N7786C/N7788C is included in the configuration

• additional (single mode) patchcords per power meter/photodetector 
input port that are supposed to measured simultaneously in a single 
sweep

• One N7786-61601 Trigger Cable (required when using N7786B)
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• One N1294A-031 trigger adapter for each B29xxA

• One M9601-87002 Connector-terminal block 2.5 mm 6-terminal for 
each M9601A (comes with the M9601A instrument)

• One M9615-87001 Connector-terminal block 2.5 mm 5-terminal for 
each M9614A/M9615A (comes with the M9614A/M9615A instrument)

• One PX0101A-001 or PX0101A-002 BNC-Ferrule Terminal Cable for 
each M9601A/M9614A/M9615A

• One BNC trigger cable (RG58, 50 Ohms) per instrument (except 
N7786B) / Lightwave Measurement System mainframe

• LAN, GPIB or USB cables 

• Personal Computer:

• Operating System: Microsoft Windows 10 (64 bit)

• Depending on the instruments, PC interfaces to LAN, USB, PCIe, 
and GPIB can be used.

• One or more licenses for the desired measurements: N7700100C, 
N7700102C, or N7700103C
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Running the LS Engine Configuration Wizard

Now that the software is installed and the instrument is connected and 
turned on, you can start the Lambda Scan Engine and run the 
Configuration Wizard.

On first startup the Configuration Wizard will come up automatically. 

NOTE
If Keysight VISA is used as primary VISA, all instruments need to be 
identified using the Keysight Connection Expert before the Photonic 
Application Suite Configuration Wizard is able to add them to the list of 
available devices. The Connection Expert is part of the Keysight IO 
Libraries. Start the Connection Expert and click the Refresh All button. 
When all connected instruments have been identified proceed with the 
steps below.

This procedure is only required if a certain supported instrument is 
connected to the PC for the first time.
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If you want to rerun the Configuration Wizard, for example to use a 
different set of instruments later on, you can select Run Configuration 
Wizard from the File menu. 

Please follow the instructions shown by the Configuration Wizard. The 
Configuration Wizard enables you to select interfaces to scan for 
connected instruments. Usually it is recommended to scan all instruments, 
but scan time can be improved and potential interruption of other users (in 
case of remotely shared USB or GPIB instruments) can be avoided by 
excluding interfaces that are not involved in the target configuration. 
Please note that N77xxC instruments connected via USB require the LAN 
or TCP/IP interface to be scanned instead of the USB interface.

After you have selected the instruments, you will see a list of selected 
instruments, to double-check your choices, which can be helpful in 
systems with lots of detected instruments. Furthermore, you can reorder 
the selected instruments using the up and down arrows in front of the 
instrument names. This can be a very helpful feature if you prefer a certain 
sequence of instruments in the engine, e.g., lasers in the order of their 
covered wavelength bands (O, E, SCL), to match the sequence in which 
they are connected to the optical switch ports or in case you want to keep 
a configuration file consistent with former versions, although the 
instrument is now connected to a different interface or has been replaced 
(different model code / serial number, all of which might lead to a different 
instrument sequence, as identified by the Configuration Wizard.)
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Starting Lambda Scan Engine

You can start the Lambda Scan Engine using ANY of the following steps:

• From the Photonic Application Suite Launch Pad. 
The Launch Pad can be accessed either by clicking its icon on the 
Desktop or by locating it from the Start menu. (Start > Keysight N7700 
> Launch Pad)
The Launch Pad gives you access to the installed components. Click on 
“Lambda Scan” to start the Lambda Scan Engine.

Figure 5 Accessing Lambda Scan Engine from the Launch Pad

• From the Start menu. Click Start > Keysight N7700 > LS Client.

• From the Windows Explorer. Navigate to C:\Program Files\Keysight\
Photonic Application Suite\bin and double-click KtPasEngineLS.exe.

• From the Windows Explorer. Navigate to a previously saved agconfig 
(LS Engine configuration) file and double-click it.
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Before starting a measurement you should make sure that the 
measurement parameters suit your measurement task.

• Controls, Measurement Parameters, and Reference Settings: 
The measurement control buttons are displayed in the top left portion 
of the application window, the measurement parameters are shown to 
the right of these and the reference properties are shown even further 
to the right. In case the reference description does not fit on your 
screen, you can see the full line in the tooltip by hovering the mouse 
pointer over the reference description control. Details of the 
measurement parameters are given in the tables in the next section.
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• Browser Tree, Measurement Graphs, and Measurement Info Panes:
The browser tree to the left of the application window lists the current 
measurement and all open files and allows configuring which 
measurements, which traces (e.g. IL, PDL, TE/TM) and which channels 
are displayed in the measurement view to the right. The measurement 
information pane can be toggled by clicking the Show/Hide Info Pane 
icon above the browser tree.

For information on how to configure the Measurement File Viewer area, i.e. 
the browser tree and the display of the measurement traces, refer to the 
Photonic Application Suite User’s Guide.

Measurement Status Window

Information on the current operation progress is displayed in the 
Measurement Status window. Sometimes user inputs are required, e.g. 
choosing whether to continue or to abort a certain operation. These user 
input requests are shown in the Measurement Status window. There will 
then be different response buttons at the bottom of the status window. 

The Measurement Status window can be resized for optimum screen 
space and the amount of status information being shown.

Enable the Status sounds check box to receive auditory notifications 
(beeps) when the status of the engine operations change, for example, 
when a measurement completes or when an error is encountered.
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Instrument/DUT Bandwidth and Measurement Trigger Timing

The LS engine performs a continuously swept wavelength measurement in 
which the data acquisition instruments sample data based on the input 
trigger connected to those instruments. The TLS makes a continuous 
wavelength sweep and generates output trigger pulses at periodic 
intervals, based on the measurement parameters. The term “actual TLS 
step size” is used below to indicate the nominal wavelength interval swept 
between wavelength samples measured by the TLS and making a trigger 
pulse. Additional intermediate triggers may be configured if the laser 
supports the oversampling function described below.

As a rule of thumb:

• larger sweep rates at the same target wavelength step cause higher 
trigger rates

• shorter target wavelength steps at the same sweep rate cause higher 
trigger rates

• increasing the trigger oversampling ratio setting causes higher trigger 
rates

Before version 3.2, the LS engine used two distinct timing configurations:

• “Regular” mode: a trigger rate of 20 kHz and 25 µs averaging time

• “High-Capacitance” mode: a trigger rate of 2 kHz and 200 µs averaging 
time

With this fixed trigger period and the user-defined TLS sweep rate, the 
resulting wavelength step was determined and could only be modified by 
changing the TLS sweep rate.

In general, there is a trade-off between a high wavelength resolution 
(small TLS steps) and low-noise measurements (large TLS steps with 
longer measurement averaging between trigger pulses) with the sweep 
rate as an additional parameter, influencing both step size and 
measurement duration.

NOTE
If the Measurement Status window is closed, it will open automatically, 
once any user input is required. It can be opened manually by checking 
Measurement Status in the View menu.

If the Measurement Status window is not visible at all, it may have been 
moved to a screen region that is currently not visible. By choosing Reset 
Status Window Position from the View menu, the Measurement Status 
window will be put to the top left corner of the application window.
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The LS engine will show warnings whenever the current sampling rate is 
too close to the instrument’s current estimated bandwidth. It is highly 
recommended to choose settings resulting in slower sampling rates then 
(increased step size, reduced sweep rate, increased averaging time). 

LS engine features, such as autoranging and high dynamic range 
measurements might change the instruments’ power/current ranges 
during the measurement, so it is important to check the measurement 
status output for any bandwidth-related warnings at the end of the 
measurement. The actual bandwidth-related warning will be shown during 
the measurement, but there will be an additional warning at the very end 
of the measurement, in case at least one instrument port was affected by 
this during any of the measurement sweeps.

When characterizing photodetectors or receiver sub-assemblies, the DUT 
can lead to a further reduction of overall measurement bandwidth in case 
there is a significant capacitance in parallel to the photodetector. This is 
something the engine does not take into account, so a correspondingly 
slow sampling rate should be chosen (i.e., slower sweep rate, larger step 
size or longer averaging time).

For photodetector or receiver characterization, using 200 us or larger 
averaging times is recommended. This can either be achieved by choosing 
appropriate sweep rate and step size settings, or by explicitly selecting the 
corresponding averaging time instead of just using the Auto setting. When 
running supported B2900-series SMU measurements in ranges below 0 
dBm, significantly larger averaging times might be required to avoid 
bandwidth warnings. To avoid accidental end up with such settings, 
autoranging will not reduce range settings below 0 dBm for supported 
B2900-series instruments. By turning off autoranging, lower ranges might 
still be set manually.

When in doubt, it is usually a good practice to start with measurements 
with rather large step sizes, then reduce the step size iteratively. As long 
as this only affects noise characteristics, the faster sampling settings can 
be considered fine. If the average PDL level or loss characteristics begin to 
change deterministically when using faster sampling settings, the 
measurement is obviously adversely affected by instrument or DUT 
bandwidth limitations and slower sampling settings must be used instead.

For PMD/DGD measurements, a good practice is actually the opposite 
approach, at least if the DGD of the DUT is completely unknown. The 
polarization-rotation effect that allows measuring the DGD, scales with 
both the DGD itself and the actual TLS step size used. It becomes 
ambiguous if either the wavelength step or DUT DGD is too large. 
Therefore, initial measurements should be done with a reasonably small 
step size, which can then be increased, if desired. To avoid long and 
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repeated measurements, a measurement over a short wavelength range, 
with a small step size can be performed to get an estimation of the actual 
DGD (assuming that the DGD is reasonably flat over the full wavelength 
range of interest), then a measurement over the full wavelength range can 
be done with the intended parameters and the initial 
short-range/high-resolution measurement can be referred to for validation 
purposes.

Once the measurement is started, the LS engine will show an estimate of 
the maximum DUT DGD that can be unambiguously characterized with the 
current measurement parameter.

In addition to the aforementioned parameters (sweep rate, step size, 
averaging time), there is also the trigger oversampling ratio (supported by 
81960A and sweep-capable 8160xA and N777xC TLS).

Usually the trigger oversampling factor is set to 1, which means there is 
one trigger generated per TLS wavelength step. Since lasers in the 8164B 
mainframes are more limited in wavelength sample memory than the 
N777xC TLS, if the sweep settings (start/stop/step wavelength and sweep 
rate) would cause the sample memory to be exceeded, the LS engine will 
automatically configure capable TLS models to generate one or more 
intermediate trigger pulses between actually measured TLS wavelength 
steps and linearly interpolate the wavelength values, if the wavelength 
sample count would otherwise exceed the instrument's sample memory.

The oversampling ratio can also be used to reduce the amount of data to 
be transferred from the TLS, which can have a relevant impact on 
measurement duration, mostly when using non-N777xC TLS. To achieve 
this, manually setting to values larger than 1 to have the TLS generate 
additional output trigger pulses will cause the engine to enlarge the actual 
TLS wavelength steps by the same factor to keep the total number of 
powermeter samples constant while reducing the amount of measured 
TLS wavelength data (with correspondingly reduced wavelength 
accuracy). 
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Receiver Measurements

The LS engine allows for characterizing wavelength dependent properties 
of passive optical components as well as O/E receiver devices. For 
measuring receiver devices, an appropriate instrument for measuring 
photocurrent is required. Such instruments are Keysight N7745A-E01 or 
N7745A-E02 specials, as well as supported Keysight 
B2900-series/M9601A/M9614A/M9615A Source / Measure Units.

Certain aspects have to be considered when using the LS engine for 
receiver measurements.

Bias Voltages

The LS engine performs measurements at the bias voltage contacts of the 
receiver device. The most important consideration is the bias voltage 
polarity. While N7745A-E01 and N7745A-E02 instruments only allow for a 
negative bias voltage, supported B2900-series/M9601A/M9614A/M9615A 
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Twoway If checked, measurement data will be obtained 
during backward scan of the TLS as well, thus 
increasing the measurement repetition rate. 
This is only supported with N777xC, 8160xA, 
or 81960A lasers. Also, configurations 
involving the N7786B polarization synthesizer 
do not support bidirectional TLS sweep mode.

TLS Power (dBm) Defines the optical output power of the laser 
source. If the specified power is not supported 
by the TLS, the TLS power will be adjusted to 
the maximum/minimum power that is 
supported. Note that this check will be made 
and the adjustment applied once an actual 
measurement operation is started, not during 
any initial measurement parameter checks.

On and Off buttons These buttons are used to switch on or off the 
laser output. Clicking “On” for a laser that is 
already switched on will have no effect on the 
state of laser output. Similarly, clicking Off for 
a laser that is already switched off will have no 
effect.

Pol. Gain Select the gain setting for the N7786B/C or 
N7788C polarimeter.
When using a non-PMD configuration, sets the 
N7786B/C polarimeter gain for the specified 
TLS (device under test and reference 
measurements).
When using a PMD configuration, sets the 
N7788C polarimeter gain for the internal path 
measurement for the specified TLS (device 
under test and reference measurements).

Return Loss Range - Return (dBm) Sets up the power range of the return loss 
module (if used). The value defines the 
maximum allowed power returned to the 
detector. Larger powers will result in clipped 
results. In case of low power at the return loss 
module (e.g. DUTs with high return loss) the 
return loss module range should be reduced to 
utilize maximum dynamic range.

Parameter Description
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Parameter Description

Store Measurement 
Raw Data in Files 

If checked, measurement raw data is stored in saved files, in addition 
to evaluated data. File size will be increased. Note that this is just for 
visual analysis of raw data traces. In order to perform the data 
processing at a later time, either to change the resolution/smoothing 
parameter, or in order to separate measurement and data processing 
from one another, use the File menu item or COM API method for 
saving measurement raw data.

Run Evaluation If checked (default), measurement data is evaluated immediately 
after data acquisition. Disable to run a quick measurement that can 
aid in verifying setup validity by looking at raw data only or for faster 
measurement repetitions by saving only the raw data for later data 
processing.

Apply SOP Drift 
Compensation

If checked (default for N7786C setups), the data processing for 
polarization-resolved measurements can considerably reduce the 
degradation of reference data over time, mostly caused by 
temperature changes and, thus, can significantly increase the 
accuracy of measurement results. A reference measurement is 
required for this functionality.
N7786C setups will only benefit from this additional data 
processing, at the cost of some small overhead in processing time; 
hence, this check box is enabled, by default.
N7786B setups will similarly benefit from the improved lifetime of 
reference measurement data; however, there is a trade-off due to the 
lower dynamic range of the N7786B polarimeter, which will cause 
some additional noise on the processed measurement results. 
Hence, by default, sop drift compensation will be disabled for 
N7786B setups.

Step Size Compatibility 
Mode

If checked, the wavelength step size is defined by sweep rate and 
averaging time. In this case, the sweep rates and the step sizes are 
coupled together under the Swept Measurement tab. Convenient for 
users upgrading from the IL/PDL measurement engine or for the 
users that prefer the earlier coupling of sweep rates and step sizes 
over the independent Sweep Rate and Step controls under the 
Swept Measurement tab.
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Table 6  Application Lambda Scan Postprocessing Settings (contd.)

Polarization Extinction Ratio Parameters

The Polarization Extinction Ratio (PER) settings are located on the PBS 
Extinction Ratio Setup tab. 

Parameter Description

PWM Init When using any direct instrument control to the power 
meter/SMU instrument(s) in between any two Lambda Scan 
engine measurements, click this button once before starting the 
next LS measurement to make sure the instruments are initialized 
correctly.

POL Init When using any direct instrument control to the N7786B/C 
instrument in between any two Lambda Scan engine 
measurements, click this button once before starting the next LS 
measurement to make sure the instrument is initialized correctly.

TLS Init When using any direct instrument control to the laser 
instrument(s) in between any two Lambda Scan engine 
measurements, click this button once before starting the next LS 
measurement to make sure the instruments are initialized 
correctly.

SOP System Init Polarization-resolved measurements require specific optimized 
states of polarization (SOPs) to be generated by the polarization 
controller. This optimization depends on the wavelength sweep 
range, on mechanical movement of the fibers up to the 
polarization instrument, and can depend on temperature changes 
as well. When taking a new reference, either at first start, after 
clearing a previous reference, or by replacing all ports in an 
existing reference, a new optimization is triggered automatically. 
When performing measurements without a reference, SOPs are 
optimized on first measurement after activating an engine. By 
clicking this button, the software will redo the SOP optimization 
at the beginning of the next measurements. This can be helpful in 
case the fiber placement or the room temperature has changed 
significantly.
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Table 7  Lambda Scan Extinction Ratio Parameters (per TLS)

Parameter Description

Wavelength Range (nm) Start and Stop Wavelength for (stepped) 
Polarization Extinction Ratio measurements. 
While From Sweep is checked, these settings 
cannot be changed.

From Sweep If checked, start and stop wavelength are 
taken from the main (sweep) measurement 
tab. Otherwise the values from the controls on 
this tab are used.

ER Samples Number of Extinction Ratio Samples to be 
obtained. When set to three, one PER 
measurement will be performed at the start 
wavelength, one at the stop wavelength and 
one at the center wavelength.
To perform the measurement at just a single 
wavelength, e.g., the center wavelength, set 
this field to one. (It is to be noted that even in 
this case two very closely placed samples will 
be plotted in the resultant graph and 
consequently in the resulting OMR data as the 
LS Engine/File Viewer does not visualize single 
data samples.)

Power (dBm) Defines the TLS power to be used for PER 
measurements.

NOTE
Since the Extinction Ratio measurement is not available in the PMD 
mode, the PBS Extinction Ratio measurement parameters are disabled in 
the PMD mode.
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Configuring Instruments Using Configuration Wizard

When you start the Lambda Scan Engine for the first time, the 
Configuration Wizard is displayed. Otherwise, perform the following steps:

1 Click File > Run Configuration Wizard.

The Configuration Wizard is displayed.
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2 To work with the LS Engine in demo mode (without connecting to any 
instruments), click the here link. Otherwise, click Next.

3 Select the interface(s) to be scanned for locating and selecting the 
connected instruments. The available options include USB/PXIe, GPIB, 
and TCP/IP, LAN.
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4 Select the instruments required for performing the measurement.

5 Once you have selected the instruments, use the up and down arrow 
buttons for the instruments to reorder them. You might want to reorder 
the detector instruments to order the ports in the results or reorder the 
lasers according to their wavelength ranges.
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6 Clicking Next displays the Configuration Finished screen with 
information about the required licenses based on the selected 
instruments.
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To perform reference operations such as obtaining new reference traces 
for individual ports, copy reference data from one port to another or clear 
reference data from certain ports, click Port/Ref. Manager to open the 
Port/Reference Manager.

NOTE
In case of polarization-resolved measurements or when the setup 
involves a polarization instrument, after performing a reference, the 
patchcord connecting the TLS with the N7786B/C must not be moved if 
it is an SMF patchcord. When loading other references files, make sure 
that the patchcord connecting TLS and N7786B/C has not been moved 
since taking that other reference.

NOTE
The information in this note applies only when using an N7786B/C and 
using the polarization-resolved measurement setting (when using 
N7786C).

When performing a reference measurement after clearing the previously 
loaded/measured reference or in case the new reference will be 
replacing all ports of the previous one, the software starts an 
optimization process for the N7786B/C polarization pattern. This 
optimization leads to a different pattern each time. Therefore, it is 
recommended to run a regular measurement right after obtaining that 
reference as a verification, which is expected to show reasonably flat IL 
and PDL traces. When adding reference data for additional ports to an 
existing reference, no such optimization is performed. So usually, in 
these cases it is sufficient to verify the average power for each port as 
displayed in the Port/Reference Manager (refer the following figure).
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This dialog also displays helpful information about the reference data as 
described below. When you are finished checking or modifying the 
reference data, click the OK button on the bottom right to close the 
Port/Reference Manager.

In the Port/Reference Manager, there will be a list of all ports for all power 
meter / SMU instruments configured for the application. To the left there is 
the instrument model code and serial number. To the right are all ports of 
the powermeter with their port numbers and check boxes (described 
below). Next to the physical port number of each power meter / SMU port 
there is a number in brackets. This is the virtual port number of each port, 
i.e., as if there was just one large array of power meter / SMU ports, no 
matter which instrument they are physically located in. This is the number 
shown as port number for measurements in the browser tree:
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NOTE
The wavelength sweep settings must be identical for all measurement 
traces in a reference. If you change the sweep settings after obtaining 
reference data on some ports, the next reference sweep will display an 
error, indicating that settings have been adjusted (if possible) or are 
inconsistent in some way.

In the former case, measurement execution will continue, in the latter, 
measurement must be aborted by clicking Cancel, then parameters need 
to be resolved accordingly before retrying.

NOTE
With an N7786B/C instrument and polarization-resolved measurements 
active, when there is no reference data available (e.g. the engine has just 
been installed, its wavelength sweep settings have changed or its 
reference has been cleared), the N7786B/C instrument settings will be 
optimized with respect to the input state of polarization. As mentioned 
before, the fiber(s) connecting the TLS and the N7786B/C must not be 
moved after taking a reference. So if the fiber has been moved, or has 
been subject to significant environmental changes, the N7786B/C 
setting optimization may become inaccurate. 

Taking a new reference on only some of the ports will not necessarily 
cause the N7786B/C to be optimized again. Optimization will be 
performed only if either the reference was cleared before (Clear button) 
or the reference is obtained using New Ref. (all). Optimization will also be 
performed if the next reference sweep will replace all currently existing 
reference traces simultaneously. Additionally, you can click the SOP 
System Init button on the Advanced tab to force an optimization 
operation at the start of the next sweep.

Whenever reference traces for at least one port remain unchanged by the 
next reference sweep, no optimization will be performed. (The intention 
is that the references on all ports use the same polarization states.)

As an indication you can check the measurement status box during the 
reference operation. If it is optimizing the N7786B/C settings, it will show 
“Optimizing Input SOPs” right after “Starting Reference Measurement”.
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NOTE
The displayed average power serves as a verification for the reference 
validity. Depending upon the TLS power selected in the GUI and the 
insertion loss of the reference connection, you should compare this value 
to the expected average power level.
After making a reference measurement, the raw data associated with the 
measurement can also be viewed for verification. To enable raw data 
trace visualization, enable the Store Measurement Raw Data in Files 
setting on the Advanced tab. Additionally, set the Detail Level to 1 in the 
Options dialog/Property Editor. (The Options dialog/Property Editor can 
be accessed by clicking the Options (or the gear) icon on top of the 
Browser tree on the left.)

NOTE
When using lasers capable of bidirectional sweeping, taking a reference 
will automatically perform a forward and a backward sweep, to 
automatically apply the matching reference data to future device 
measurements.

NOTE
Using reference data on some ports and no reference data on other ports 
is not supported. Neither is it supported to use polarization-resolved 
reference data on some ports and non-polarization-resolved reference 
data on other ports. Whenever you try to do either operation, the engine 
shows a corresponding error message.
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 5 Select the ports for which you want to perform the reference 

measurements. You can perform a single measurement sweep on 
multiple ports simultaneously by using the check boxes above the 
individual ports. You can also select or deselect all the ports 
corresponding to an instrument by clicking the Select All or Select 
None buttons just under the instrument descriptor.


